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Введение в  LabVIEW 



Решаемые задачи
• Научиться основам графического 

программирования
• Возможность применения LabVIEW для 

создания собственных приложений
- Сбор, анализ, отображение и сохранение данных
– Поиск и использование функций анализа и 

обработки
– Использование различных типов данных 
– Запись и печать  результатов



 Графическая среда разработки LabVIEW

• Среда графического программирования
• Исполнение кода на различных ОС и устройствах
• Широкий диапазон приложений



Приложения на базе виртуальных приборов

• Разработка
– Обработка сигналов и 

видеоизображений
– Встраеваемые  программируемые 

системы
• (PC, DSP, FPGA, Microcontroller)

– Построение прототипов и 
моделирование

– Многое другое
• Управление

– Автоматическое управление 
динамическими системами

– Мехатроникаи робототехника
– Многое другое

• Измерения
– Элекроника и Электротехника
– Основы измерительных технологий
– Многое другое

Design Prototy
pe Deploy

Единая платформа разработки



Технологии  NI  – Интегрированная  
аппаратная платформа
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Digitizers and DMMs

Multifunction 
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Dynamic
Signal Acquisition

Digital I/OInstrument
Control

Counter/
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Machine
Vision

Motion 
Control

Distributed I/O and
Embedded Control

Laptop PC PDADesktop PCPXI Modular Instrumentation

Signal Conditioning
and Switching

Unit Under Test



Среда LabVIEW

A. Сбор данных при помощи ПК
• Data Acquisition Devices

– NI-DAQ
– Симулятор сбора данных
– Звуковая карта 

B. Среда  графического программирования LabVIEW 
        Лицевая панель / Блок диаграмма

• Палитра функций  и инструментов
C. Компоненты приложений  в  LabVIEW 
         Создание под ВП

•  Графическое построение кода
D. Дополнительное контекстное меню помощи

• Поиск функций
• Особенности работы в LabVIEW



Настройка оборудования

• Устройства сбора данных (DAQ)
– Карты USB, PCI, or PXI Device
– Configured in MAX

• Симулятор устройства  (DAQ)
– Симуляция DAQ устройства 
– Configured in MAX

• Звуковая карта
– Встроенная во многие ПК



 Технические характеристики устройств

Звуковая 
карта*

NI USB 
DAQ

NI PCI DAQ Приборы*

AI полоса 
пр

8–44 KS/s 10–200 
KS/s

250 K–1.2 Ms/s 20kS/s–2 GS/s

Точность 12–16 bit 12–16 bit 14–18 bit 12–24 bit
Портатив. x x — some
AI каналы 2 8–16 16–80 2
AO каналы 2 1–2 2–4 0
AC or DC AC AC/DC AC/DC AC/DC
Запуск — x x x
Калибровк
а

— x x x



Что такое  MAX?
• MAX - Measurement & Automation Explorer.
• MAX конфигурирует и отображает  все устройства  

National Instruments- DAQ, PCI/PXI instruments, GPIB, 
IMAQ, IVI, Motion, VISA, and VXI devices.

• Окно для конфигурации и тестирования .

Найдите иконку  
на Рабочем столе



Настройка устройств

• Используйте  MAX для :
– Конфигурирования и тестирования Вашей 

карты сбора данных (DAQ)



Настройка устройств
• Используйте  MAX для :

– Конфигурирования и тестирования Симулятора 
карты сбора данных (DAQ)



Настройка устройств

• Используйте  Windows для :
– Тестирования Звуковой карты

Разблокируйте 
микрофон



Пуск »Программы»National Instruments LabVIEW 

Startup Screen:

Начать с нового VI:
Новый VI

Начать с примера:
Examples»Find 

Examples…

»

или

Откройте и запустите LabVIEW



Каждый ВП имеет 2 окна

Лицевая панель
• Интерфейс пользователя

–  Элементы управления = 
Входы

–  Индикаторы = Выходы

Блок диаграмма
• Графический код

– Данные передаются  по 
проводникам от элементов 
управления, через функции, к 
индикаторам

 Программа в LabVIEW называется 
Виртуальным прибором (ВП)



Элементы управления и  индикаторы

Числовые или слайдовые:
индикаторы

Числовые элементы 
управления:

Вид 
палитры



Палитра всех функций

Структуры:
Цикл по условию

Размещаются на блок- диаграмме



• Рекомендуется: Включить опцию «Автоматический 
выбор инструментов»

• Палитра может быть доступна на лицевой панели и  
на блок диаграмме

Operating Tool

Positioning/Resizing Tool

Labeling Tool

Wiring Tool

Палитра инструментов

Automatic Selection Tool

Доступные инструменты опции «Автоматический инструментов выбор» 
:



Кнопка запуска 

Кнопка запуска в 
непрерывным режиме

Экстренная остановка

Отладочный индикатор

Дополнительные кнопки управления 
на блок-диагрмме

Управление программой и блок-диаграммы

Retain Wire Values Button
Кнопки пошагового доступа 
в узлы кода



Блок- диаграмма

 Окно лицевой панели

Создание  ВП

Входной
терминал

Выходной
термнал

Логический эл. управления

Графический индикатор



• Исполнение кода 
– Зависит от потока данных

–  Код на блок-диаграмме не 
исполняется с лева на право

•   Код исполняется по мере 
поступления всех данных на 
все входные терминалы 

• Отображение происходит по 
мере поступления всех  данных 
на все выходные терминалы.

Поточный метод программирования



Техника отладки 
• Поиск ошибок

• Визуальная отладка

• Probes

Нажать  на кнопку Запуск 
Появится окно с описанием ошибки.

Нажать на кнопку Execution Highlighting;  
Визуальная передача данных . Значения 
отобразятся на проводниках 

Правый кнопка мыши по проводнику для 
отображения индикатора пробника



Сбор данных с использованием DAQ

• Используя  LabVIEW :
– Оцифруем сигнал  при 

помощи  DAQ устройства



Сбор данных со звуковой карты
• Используя LabVIEW  и стандартное оборудование



Окно контекстной помощи
• Help»Show Context Help, нажать <Ctrl+H>
• Переместить курсор к объекту для обновления

Дополнительная 
помощь
– Правая кнопка мыши по 

иконке ВП и выбрать 
Help, или

– Выбрать “Detailed 
Help.” на контекстном 
окне



Горячие клавиши в LabVIEW

– <Ctrl+H> – Активация/деактивация окна Help
– <Ctrl+B> – Удаление оборваных проводников 
– <Ctrl+E> – Переключение между лицевой панелью и 

блок -диаграммой
– <Ctrl+Z> – Отмена действий 
– Tools»Options… – Настройки в LabVIEW

• VI Properties– конфигурация свойств ВП и  т.д. 



Элементы типовой программы

A. Циклы
• По условию
• С заданным числом итераций

B. Функции и под ВП
• Виды функций
• Создание собственных  функций (SubVI)
• Палитра функций  и  их  поиск

C. Принятие решений и ввод / вывод файлов
      Структуры CASE

• Выбор 
• Ввод и вывод файла



Циклы

• По условию
– i Индикатор текущей итерации
– Всегда запускается как 

минимум один раз
– Исполняется до поступления на 

терминал условия выхода 

• С заданным количеством
– i Индикатор текущей итерации
– Исполняется согласно значению  

счетчика N на терминале

While Loop

For Loop



Процесс заключения в цикл

1. Выбрать из «Структуры»

2. Обвести вокруг заданного кода

3.  Или переместить код внутрь цикла 
и завершить соединение проводников



Виды функций ( Functions Palette)
Экспресс : Функции с  интерактивным окном конфигурирования 
(голубая иконка)

Стандартные : модульного типа  ВП с возможностью 
переконфигурирования 

Базовые : основные базовые функции LabVIEW; без лицевой 
панели и блок диаграммы (желтый цвет)



Какие виды функций доступны?
• Ввода и Вывода

– Моделирования сбора и  генерации данных
– Сбора и генерации реальных сигналов при помощи 

DAQ
–  Управления приборами (последовательный и  КОП 

(GPIB )
–  Вызов  ActiveX компонентов для связи с другими 

программами
• Анализа и обработки

– Анализа и обработки  различных типов сигналов
– Статистики
– Различных разделов математики 
– Дополнительных временных 

• Сохранения и записи
– Ввода и вывода файлов

Палитра Экспресс-Функций



Как найти функции в палитрах? 

• Палитры содержат сотни функций
• Нажать кнопку «search» на строке 

палитры и ввести название 
функции

•  Нажать и выбрать нужную 
функцию из списка 

• Дважды нажать на иконку функции 
для отображения подпалитры

• Перетащить нужную функцию на 
блок-диаграмму 



Создание под ВП (SubVI)
• Выделить код на блок-диаграмме  для создания под ВП 
• Выбрать из  Меню Edit « Create SubVI»



 Порядок работы функций в ВП 

Function Pseudo Code
function average (in1, in2, out)
{
out = (in1 + in2)/2.0;
}

Под ВП на блок- диаграмме

Calling Program Pseudo 
Code

main
{
average (in1, in2, pointavg)
}

Вызов  ВП на  блок-
диаграмму



Анализ данных

• Используем функции Экспресс для:
генерации и отображения амплитуды и частоты сигнала



Анализ данных 
• Используем функцию Экспресс для:

– Сбора и отображения амплитуды и частоты 
сигнала



Принятие решений в  LabVIEW
1.  Структуры «Case»

2.  Функция «Выбор»
(a) (b)

(c)



Файловый ввод/вывод
File I/O – передача данных в/из файлов
•  Файлы могут быть в виде бинарных, тестовых или таблиц
•  Запись/Чтение LabVIEW Measurements file (*.lvm)

Запись в  LVM файл Чтение из  LVM файла



Принятие решений и сохранение данных

• Используем структуру «case» для:
– Сохранения данных при выполнении 

определенного условия



Запись/чтение в /из файла

Открыть/
Создать/
Заменить 

Читать
или

Записать в
 файл

Закрыть
файл

Проверка 
на 

наличие
ошибок



Отображение результатов
A. Отображение данных на лицевой панели

• Элементы управления и индикаторы
• Графики 
• Временные циклы

B. Обработка сигналов
• MathScript ( математические скрипты)
• Массивы
• Кластеры
• Элементы сигнала



Типы элементов управления и индикаторов
• Числовые типы  данных

– Ввод и отображение числовых 
данных

– Слайдеры  и  ручки
• Логичекие типы данных 

– переключатели и диоды
• Массивы и матрицы

– Числовые 
– Графики диаграмм
– Графики осциллограмм 
– Графики интенсивности
– Графики объемных изображений, 

поверхностей и моделей
• Декоративные панели

– Переключаемые панели
– Стрелки

• Другие элементы и типы данных
– Строчные и текстовые  данные
– Картинки/отображение фотографий
– Компоненты ActiveX 

Палитра  элементов



Графики диаграмм
Графики диаграмм – Специальный числовой индикатор, 

отображающий  собранные данные  во времени
•  Обновление происходит с момента получения на вход  

терминала каждого  значения

Функции»Экспресс»Graph Indicators» Chart



Графики осциллограм
Графики осциллограм – специальный числовой 
индикатор, отображающий массив данных

 

• Обновление графика происходит по завершении 
буферизации всех точек.

• Цикл может накапливать данные в буфер

Functions»Express»Graph Indicators»Graph



• Циклы могут 
аккумулировать массивы 
на границах 

( автоиндексация)
• В цикле For Loops 

автоиндексация по 
умолчанию

• Правая кнопка мыши по 
границе цикла активирует/ 
деактивирует индексацию

Создание массивов с использованием Циклов

Проводник  стал толще

 Толщина проводника не 
изменилась

Авто- индексация 
отключена

Авто- индексация 
включена

Отображается только 
значение последней 
итерации  

1D Array

0 1 2 3 4 5

5



Создание массива

Выбираем с палитры Controls»Modern»Array, Matrix, 
and Cluster иконку контейнера массива.

Помещаем на лицевую панель



Создание массива
1. В контейнер массива помещаем нужный нам элемент 

управления или индикатор 



Для чего нужен временной цикл?
1. Задержка времени исполнения кода

• Настройка  Time Delay Express VI для работы кода с определенным 
промежутком времени (работа с For and While циклами).

2. Временной цикл
• Настройка временного цикла  While loop для заданного dt.

Временной циклЗадержка времени



Свойства элементов управления и индикаторов

• Свойства характеризуют настройки объектов
•  Щелчок правой кнопкой мыши по объекту

• Свойства объектов:
– размер
– цвет
– настройки шкал
– цвет шкал 
– курсор
– и т.д.



Анализ сигнала
• Используя курсор графического индикатора:

– Измерить частоту и амплитуду синусоиды



Mathscript

• Возможности разработки 
приложений обработки сигналов, 
анализа и математических 
уравнений в текстовом коде среды  
LabVIEW
– Более 500 встроенных функций
– Синтаксис схожий с популярными 

языками математического 
моделирования 

– Встроенные в   LabVIEW основанный на 
оригинальной  среде  математической 
разработки  MATRIXx

LabVIEW MathScript



Математические скрипты в LabVIEW

• Интеграция существующих скриптов для быстрой 
разработки приложений в LabVIEW

• Интерактивность и легкость разработки, 
• Разработка математических алгоритмов, обработка 

и анализ в одной среде LabVIEW
• Возможность интеграции математического и 

графического синтаксиса в одном ВП

Поддерживаемые интерфейсы:
Узел MathScript script node MathSoft software
Mathematica software MATLAB® software
Maple software  Xmath software



Математический код  в MathScript Node
• Введение уравнений в текстовом формате 
• Входные и выходные переменные на границах цикла
• Синтаксис схожий с математическими  текстовыми 

языками 
• Богатая библиотека готовых решений

(Functions >> Programming >>
Structures >> MathScript)



Интерактивное окно MathScript

• Быстрая разработка и алгоритмы отладки

(LabVIEW >>Tools >> MathScript 
Window)

Окно
Вывода

Переменны
е

Отображение в 
форматах

Коммандное 
окноm-file script

• Создание и 
редактирование 
переменных

• Отображение в 1D, 
2D, и 3D .



LabVIEW и Simulink



Использование Script

Используя узел MathScript and Интерактивное 
Окно MathScript  для обработки и сохранения 
данных.



Обзор типов данных  в LabVIEW



Комплекс возможностей 



Дополнительные возможности

A. Дополнительные типы данных
• Кластеры

B. Управление потоком данных
• Сдвиговые регистры
• Локальные переменные

C. Разработка больших приложений
• Окно навигации 
• Проект в LabVIEW



Кластеры

• Объединяет различные типы данных
• Аналогия с  struct в языке C
• Могут быть группами  элементов управления или 

индикаторов
• Схожи с многожильным проводом 
• Порядок  элементов в кластере очень важен



Создание кластера
1. Выбрать контейнер кластера с палитры.

Controls»Modern»Array, Matrix & Cluster

2. Вставить желаемый 
объект в контейнер.



Функции кластеров
• Местоположение Cluster & Variant, подпалитра 

Programming 
• Могут быть доступны при щелчке правой кнопки 

мыши по терминалу кластера

Bundle

(Terminal labels 
reflect data type)

Объединение в кластер по 
имени



Использование массивов и кластеров

Отображение на графике
• t0 = начальное время 
• dt = время между отсчетами
• Y = массив  по оси Y

Два способа создание кластера графиков

Создание графика (абсолютное время) Кластер (относительное время )



Сдвиговый регистр – доступ к предыдущим итерациям

• Доступен на правой и левой границе циклов
• Правая  кнопка мыши по границе и  выбор из меню Add Shift 

Register 
• Правый терминал сохраняет  данные последней итерации
• Левый терминал сохраняет данные предыдущей итерации 

для начала следующей.

До начала 
выполнения 

цикла

Первая 
итерация

Вторая 
итерация Последняя 

итерация

3
Инициализация



Локальные переменные

• Локальные переменные обеспечивают передачу данных между 
параллельными циклами

• Значение элемента управления или индикаторы может быть 
считанно или записано в разных местах программы в  
нескольких местах



• Отображает текущий 
участок программы

• Идеально для больших 
приложений

 Окно навигации в LabVIEW



 Проекты в LabVIEW

• Группирует и организует ВП
• Управление аппаратными 

средствами
• Управление и загрузка на 

различные платформы
• Создание библиотек и 

исполняемых файлов
• Управление большими 

приложениями в  LabVIEW a

(LabVIEW»Project»New)



Программа   сертификации  LabVIEW

Certified LabVIEW 
Developer

Certified LabVIEW Associate 
Developer

Certified 
LabVIEW 
Architect

Architect
• Mastery of LabVIEW 
• Expert in large application development
• Skilled in leading project teams

Developer
• Advanced LabVIEW knowledge 

and application development 
experience

• Project management skills

Associate Developer
• Proficiency in navigating

LabVIEW environment
• Some application 
 development experience

Fundamentals Exam
•Pre-Certification Skills Test

Бесплатный экзамен LabVIEW



 Интеграция Multisim с LabVIEW
1. Create Schematic 2. Virtual Breadboard 3. Simulate

4. PCB Layout 5. Test 6. Compare


